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Addendum

Release Notes

Ultimatte KnockOut Software Version 1.1 for the Macintosh

In addition to some minor bug fixes, Version 1.1 of Ultimatte KnockOut has been revised to
include:

1.) Support for 16-bit images.  

2.) No 4000 pixel size limitation. 

3.) The UKO project file format is compatible with the new Windows version of the
programme. Older projects can be made Windows compatible by simply opening them
and then re-saving using version 1.1.

4.) Ultimatte KnockOut will run in Demo mode if no dongle is detected.

5.) Windows-style Tool Tips. Placing the cursor over tool icons reveals the tool’s usage.

6.) ICC color profiles for image files are maintained. 

It was necessary to remove two features in order to support our new feature set.  

1.) Info Palette

2.) Inverse Selection

Note: Ultimatte KnockOut Software is NOT compatible with Mac OS version 8.5.X.  There is
a bug in the Macintosh OS for which we have not been able to provide a work-around.
Apple has solved this problem with the release of OS 8.6 
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Introduction

Ultimatte KnockOut approaches the task of masking an image from a unique per-
spective.  Most masking  programs, whether plug-ins or stand-alone applications, are
designed to help you precisely and speedily find an object's edges. This can be useful
when dealing with complicated shapes with simple edge transitions.  Once the edges
are defined, and a corresponding mask channel is generated, all that remains is to
soften the edges an appropriate amount and the image is ready for the finishing
touches and compositing.  The limitations of these techniques are well known to
those skilled in the art.  Hair detail is always one of the 'finishing touches' that can
require hours of work and the result is always a compromise.  Before the availability
of Ultimatte KnockOut, blurred or out-of-focus edges, smoke, glass, shadows and
other transparent or translucent objects were virtually impossible to mask properly.

The limitations of other masking software always become apparent when soft transi-
tions exist.  Ultimatte KnockOut stands apart from all others in that it recognizes that
there really are no edges.  There are only transitions.  Even the sharpest edge has a
transition where at least one pixel is a mixture of the color of the foreground subject
and whatever color was behind it.  Depending on such factors as motion (camera or
subject), depth of field, film resolution, scanning resolution, lens quality, or the actu-
al softness or transparency of the subject itself, edge transitions can vary from a cou-
ple of pixels to a transition that can nearly fill the frame.  The unique strength of
Ultimatte KnockOut is that it will reproduce the soft transitions of foreground edges,
however wide or variable in density, while removing any trace of the visible back-

Introduction
There are no edges.  There are only transitions.

original alpha channel produced by KnockOut composite
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ground in that transition.  When this ‘knocked out foreground’ is combined with a
new background the transitions will have the same transparency as the original. 

The process required to achieve these results is simple. Two selection lines, Inside
Object and Outside Object, (represented by lines of "crawling ants"), are drawn
using the program’s selection tools. Remembering that all edges are transitions, the
Inside Object selection line is drawn within the foreground subject as close to the
edge of the transition as is needed to insure that the colors through which the line
passes are the same as the colors adjacent to the transition itself. The Outside Object
line, using this same principal, is drawn through the background area surrounding
the foreground subject.  When these boundary lines are complete, activating the
'process' function enables the special logic that will magically knock out the fore-
ground image from the background, preserving transparencies and all of the fine
detail required to give realistic results.  Shadows are preserved using the same tech-
nique just described.  By drawing with the Inside Shadow and Outside Shadow tools
a separate alpha channel for the shadow will result.

Installation
With the computer shut down, attach the hardware security key on the Apple
Desktop Bus which can be found on the back of the computer where the keyboard
is normally connected (insert the keyboard into the security key) or between your
keyboard and mouse.  Restart the computer to activate it.  Install Ultimatte KnockOut
by double-clicking on the Installer icon and following the directions which appear
onscreen.  

System Requirements 
and Application Memory Size
Ultimatte KnockOut requires Macintosh OS System 7.5 or higher running on a
PowerPC or G3 system.  The amount of RAM that Ultimatte KnockOut requires
depends upon the size of the image with which you are working and your Preferences
settings. You need to have a minimum of at least five times as much free RAM (eight
times recommended) as the largest image size you wish to process, plus about  two -
three megabytes. For example, 10MB images would require a minimum of approxi-
mately 53MB of free RAM.
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You can maximize the feature availability of Ultimatte KnockOut by increasing the
application memory size.  If you have sufficient RAM, you can allocate some of it to
Ultimatte KnockOut and some to other programs so that they can be active at the
same time.  If you have limited RAM, run Ultimatte KnockOut by itself and use the
following steps to maximize the amount of RAM available to the program.

Allocating RAM to Ultimatte KnockOut:
1.) Start up your computer and choose About This Macintosh from the Apple menu
before running any applications. (You cannot change the application memory size
while the application is running.) Make a note of the Largest Unused Block Value,
showing the amount of RAM available.

2.) In the Finder, select the Ultimatte KnockOut program icon and choose Get Info
from the File menu.

3.) While in the Ultimatte KnockOut Info window, set the Preferred Siz e option to
any value up to 90% of the Largest Unused Block value you noted in Step #1 above.

4.) Close the Ultimatte KnockOut Info window and launch the program whenever
ready.

Customer Support and Feedback
We think that we've created quite a wonderful tool, but we were only able to do so
because we've been working closely with artists throughout the Ultimatte KnockOut
development process.  We invite you to help us refine and improve it in the future.
We'd appreciate your feedback and suggestions, problems and observations.  As the
product matures, we'll incorporate your requests to make Ultimatte KnockOut an
even more exciting and useful product.

You can visit our Web site at www.ultimatte.com for a wealth of information about
Ultimatte KnockOut, including product updates, hint and tips, etc.  Please send your
comments and inquiries to us via e-mail at uko_support@ultimatte.com

Technical Support
Technical Support is available via e-mail at uko_support@ultimatte.com , or via the
telephone from 8:00AM to 4:30 PM Pacific Time at (818) 993-8139
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Product Registration
Please register your copy of Ultimatte KnockOut.  By doing so, you'll be kept advised
of new versions of the product and special upgrade offers, and will become eligible
for our technical support services.  You can register the product by completing and
mailing the enclosed postage-paid Registration Card or by registering online while
using the installation program.
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Getting Started

There are no edges. There are only transitions.

The reason that other masking techniques produce mediocre results is their failure to
deal appropriately with the edge transitions that are characteristic of ALL pho-
tographed images.   Both an alpha channel (mask) and a processed foreground, where
the background colors have been completely removed, are required to produce real-
istic composites. Ultimatte KnockOut creates BOTH of these essential components
ready for combining with a new background.

original processed foreground

alpha channel composite

Getting Started
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Creating Selection Lines
Your job as a user is to define the subject you would like to mask out of the original
image by drawing two sets of lines or selections. The first selection (Inside Object )
should be drawn in the foreground subject as close to the transition area (see the
Introduction on Page 1 for a description) as is necessary to pass through the colors
that exist at the transition while taking care not to pass through any actual transition
areas.  Similarly, the second selection (Outside Object ) should surround the fore-
ground subject as close to the transition as is necessary to pass through the back-
ground colors that, as before, exist at the transition while avoiding any actual transi-
tion pixels.  Note that a line of black and white crawling ants represents the current-
ly active selection while inactive selection lines are gray and white.

The uniformity of the colors in the background and foreground areas determines
how closely the lines must be drawn to the transition edge.  For example, a white rab-
bit sitting in green grass would require only loosely drawn lines, while a leopard in a
colorful jungle setting would require lines drawn much closer to the transition area.
To reiterate an important principal to remember, which applies equally for drawing
both the Inside Object and Outside Object selections: at no time should either
boundary line ever touch any pixel within the transition area.  When either Inside
Object and Outside Object lines are drawn within the transition area the result is
either a loss of the transition or inclusion of background color in the transition area.

Single Pixel Selections
Sometimes part of the object you are trying to preserve cannot be defined by using
the Inside Object tool because the object, even though it is solid, is too thin to draw
within. Or perhaps a transparent section separates it from the interior of the transi-
tion area. In cases like these you can select individual pixels which you would like to

image showing both inside and outside selection lines
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preserve as 100% Inside Object selections by using the single pixel selector, accessed
by holding down the Control key while using the Inside Object tool. You’ll notice
the cursor change into a pushpin. Note that single pixel selections can only be made
when the zoom level is 100% or greater.

Similarly, if areas of background colors fall within the boundaries of the object itself
(see the photo below of the stuffed dog), these areas can be selected as 100% Outside
Object areas by using the Outside Object tool with the Control key depressed to
take single pixel samples of the background. The cursor will change into a pair of
tweezers. Single pixel selections can only be made at a zoom level of 100% or high-
er.

Selecting Shadows
Ultimatte KnockOut can also retain shadows that you might want to preserve along
with the object. The Inside Shado w and Outside Shado w selection tools allow you
to draw a separate set of selection lines that will preserve the shape and edge transi-
tion characteristics of a shadow, remove the underlying colors and textures and let
you save the shadow selection as a separate Adobe® Photoshop® channel, allowing
you to control its density and other attributes.

image showing background color falling within the boundaries of the Object
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Preparing Your Images

File Formats
Ultimatte KnockOut will process images that are in 3-channel (RGB), single-layer
Adobe® Photoshop® file formats.  If your image uses another file format, open it in
Photoshop and save it in Photoshop format before attempting to load it into Ultimatte
KnockOut.

IMPORTANT: If your image has a pixel width dimension of greater than 4,000 pix-
els, it cannot be opened in Ultimatte KnockOut. Resize to a smaller pixel width.

Cropping
In order to minimize the memory requirements of the program and to speed up
screen refresh and processing times, we recommend that you crop your image in
Photoshop an appropriate amount to include as much of the image as necessary to dis-
play the entire object that you want to knock out.

Preferences Settings
The Preferences Palette is used to select various default settings for the program and
can be accessed from the Edit menu.  Here you can select the following:

1.) Shadow Memory Buffer
If you wish to preserve shadows using a separate alpha channel, check this box.  If
you are trying to conserve memory and want turn off shadow selections, make sure
that this box is not checked.  You will still be able to retain shadows using the Inside
and Outside Object tools, but the program will output one combined alpha channel
for the object and the shadow, and you will not be able to manipulate the shadow
separately.
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2.) Previous Process Viewing
If you have enough RAM allocated and would like to be able to compare the results
of the current and the last previous processing of an image, check this box.  After pro-
cessing, you can toggle between the results of the old and new processing by pressing
the F2 key for the composite view, or F3 for the alpha channel view. When
unchecked, you will only be able to view the very last processing results.

3.) Beep When Finished
If you would like to be alerted with an audible beep when processing of an image is
completed, enable this setting.

4.) Selection Validity Testing
Ultimatte KnockOut will test the selection lines you have drawn before processing to
ensure that your Inside Object selection lines are entirely enclosed by your Outside
Object selection lines.  If you would like to disable this function, which improves the
program’s performance, uncheck this setting.

It is not necessary to re-start the program to make your Preferences active.  Any win-
dow opened after you have changed the Preferences setting will employ the new set-
tings.  If your image or project window is already active, save it, close it and re-open
it to activate the new Preferences settings.

Projects and Exporting

Opening an Image and Saving it as Project
After you launch Ultimatte KnockOut, a file requester will appear where you  can
select the image file that you want to open.  Once you have opened an image and
begin creating selections, we recommend that you save your work as a Project.  This
will save the image and the lines you have drawn.  The software will add a .UKO
(Ultimatte KnockOut) extension to the file name to indicate that it is a project file.
However, you can use any file name and extension.  Ultimatte KnockOut projects can
only be opened by Ultimatte KnockOut.

Opening an Existing Project
Previously saved projects can be opened by using the Open option in the File menu.
Your image with any previously drawn selections will be opened.  A dialogue box will
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appear asking it you’d like to Process your image.  If you accept by clicking on the
Process button, Ultimatte KnockOut will Process your image using the selections you
created before you saved the project.

Exporting Images
We recommend that you save you work in the form of a project.  This will save all of
the selection lines that you have drawn. The Export selection in the File menu will
save the processed foreground as either a 4 (RGB plus Alpha channel) or 5-channel
(RGB plus Alpha plus Shadow Alpha) Photoshop file.
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Making and Modifying Selections

Creating the Inside Object Selection

Using the Inside Object tool on the tool palette, begin by making an enclosed selec-
tion that loosely traces along the inner boundaries of the object's edge transitions.
Once you have created this loose definition of the inner boundaries, you can refine
your selection by adding to it or subtracting from it, usually while zooming in an
appropriate amount. 

The Inside Object selection line should be drawn as close to the transition as is need-
ed to pass through the color that is the same as the color that actually enters the tran-
sition.  An object of uniform color only needs a very loose Inside Object selection.
Multicolored objects (e.g., a plaid shirt) would require a much closer line.  Care must
be taken that when drawing near an edge that at no time are transition pixels
touched.  If transition pixels are drawn through inadvertently, the result will be those
pixels, and nearby pixels having the same RGB value, becoming solid in the knocked

correct

incorrectincorrect

correct

Making and
Modifying Selections
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out transition.  Whatever color in the sampled transition that is contributed by the
background will remain in the incorrectly solid transition area.  The line will need to
be redrawn outside the transition in the opaque part of the subject.

Adding to the Inside Object Selection
You can add to the existing Inside Object selection by using the Inside Object tool
with the Shift key held down. The selection that results will contain all of the pixels
in the original selection plus those contained in the new selection.  If instead of draw-
ing in freehand mode you would like to constrain the tool to straight lines while
adding to your selection, depress the Control and Shift keys while using the tool.

Subtracting from the Inside Object Selections
You can subtract from the Inside Object selection by using the Inside Object tool
with the Option key held down. The selection that results will contain all of the orig-
inal selection minus those pixels contained in new selection. If instead of drawing in
freehand mode you would like to constrain the tool to straight lines while deleting
from your selection, depress the Control and Option keys while using the tool.

Making Single Pixel Inside Selections
It is sometimes helpful to select individual pixels which fall outside of the main
Inside Object selection area in order to provide the program with the color values it
needs to preserve object details. With the Inside Object tool selected, hold down the
Control key (the pointer will become a pushpin) while clicking on a pixel
which contains the color that should be processed as 100% foreground object.  A
selection line will encircle the chosen pixel. Note that single pixel selections can only
be made when the zoom level is 100% or greater.

This feature can be useful when glints on hair detail are lost, but you should only use
the pushpin in opaque areas. If the glint contains even one pixel that is opaque and
it is selected it will correct the problem.  Likewise is true for any detail that is lost
where opaque pixels can be selected.  
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Creating the Outside Object Selection

It is important that you keep in mind a couple of concepts when creating your
Outside Object selections:  

1.) Draw your lines as close to the outer border of the object's transition area as 
is necessary to trace over the colors that make up the exterior component of 
the transition. 

2.) Your Outside Object selection must completely enclose the Inside Object
selection in order for the program to determine where the transitions lie.

Adding to the Outside Object Selection
You can add to the existing Outside Object selection by using the Outside Object
tool with the Shift key held down. The selection that results will contain all of the
original selection plus those contained in the new selection.  If instead of drawing in
freehand mode you would like to constrain the Outside Object tool to straight lines
while adding to your selection, depress the Control and Shift keys while using the
tool. 

Subtracting from the Outside Object Selection
You can subtract from the Outside Object selection by using the Outside Object tool
with the Option key held down. The selection that results will contain all of the orig-

correct

incorrectincorrect

correct
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inal selection minus those pixels contained in new selection. If instead of drawing in
freehand mode you would like to constrain the tool to straight lines while subtract-
ing from your selection, depress the Control and Option keys while using the tool.

When creating the outside selection, remember to be careful not to draw in the tran-
sitions.  When an Outside Object line is drawn through a transition the result is a
loss of the transition in the knocked out image. 

Using the Auto Outside Function
If you expect your Outside Object selection to be relatively similar in shape to the
Inside Object selection, and your inner selection is drawn close to the transition area,
then you may want to use the Auto Outside function found in the Selections menu
after you have drawn the inner lines. When you select Auto Outside it will use the
existing Inside Object selection to create a new line or set of lines which will com-
pletely enclose the inside selection.  This new set of lines will be spaced an appropri-
ate distance from your Inside Object selection based upon the resolution of the
image.  You can expand the distance between the Inside Object line and the auto-
matically created outer line by using command ] on the keyboard, or contract the
distance by using command [ . These expand and contract functions can also be
accessed from the Selections menu.  Once you've let the program generate the outer
line, you can then use the Outside Object tool to modify and reposition the line as
necessary.

Note:  If you choose to draw the Outside Object line first, the Auto function will
generate the Inside Object selection for you automatically.  If both lines are already
drawn, the selection that is currently active will be the one that will increase/decrease,
overwriting the inside or outside selection.

Making Single Pixel Outside Selections
It is sometimes helpful to select individual pixels which are not part of the main outer
selection area in order to provide the program with the color values it needs to pre-
serve object details.  As an example, sometimes the background is still visible through
loose flyaway hair. If 100% background pixels can be found amongst the detail that
are not obscured by any foreground transition then selection of these pixels will cause
them and any other nearby similar background pixels to be properly subtracted.
With the Outside Object tool selected, hold down the Control key  (the pointer will
become a pair of tweezers)       while clicking on a pixel which should be processed
as 100% background.   A selection line will encircle the chosen pixel. Note that sin-
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gle pixel selections can only be made when the zoom level is 100% or greater.
Experimentation with this technique under various circumstances will quickly allow
the user to build an intuitive feel for when and where to take these samples. 

Selecting the Transition Complexity Setting

The Transition Complexity settings have an important effect on the way your images
are processed.  They are provided so that you can instruct the program about the
nature of the transition area.  There are four settings available that can have a rather
profound effect on how the program processes the information that you have pro-
vided it by drawing the Inside Object and Outside Object selections.  These are:

1.) Low
2.) Low to Medium 
3.) Medium to High  
4.) High. 

Deciding which setting is best for any particular image depends upon the complexi-
ty of the transition area, i.e., the area between the inner and outer selection lines that
you draw. We suggest that you read the descriptions and examples below and try pro-
cessing the same image with different Transition Complexity settings while noting
the results.

1.) Low - Use for images with uniform colors in both the foreground and the back-
ground. Images with low noise levels, minimal detail and narrow transition widths
can be processed with this setting. 
Example:  A white stuffed animal on a uniform background.

2.) Low to Medium - Use for images with more complex foregrounds but with rela-
tively simple backgrounds.  The foreground object can have more detail and more
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variable colors in the transition area.  Wider edge transitions are acceptable. The
background remains even and consistent. 
Examples:  Studio portraits. People (with hair) against a uniform background.  In
focus shots of most subjects against uniform backgrounds.

3.) Medium to High - Use for images where the foreground is relatively simple and
the background is complex and/or grainy. This setting can handle wider transitions,
soft blurs, out-of focus edges and motion blurs in the foreground. 
Examples:  A drinking glass against a uniform background.  A plain, brown teddy
bear on a plaid background. 

4.) High - Use for images where both the foreground and background have a great
amount of detail along the transition. The best setting for transition edges where
both the inner and outer lines are drawn close to the edge transition.  
Examples:  A single person to be extracted from a crowd scene.  A leopard in a field
of flowers.

A good indicator of which Transition Complexity setting you should use is the prox-
imity of the lines you have drawn near the edge transition area.  Remember that the
lines you draw must cross through the colors that make up the beginning of the tran-
sition.  So, in a case where colors remain consistent from deep inside an object all the
way to the beginning of the edge transition, a loosely drawn Inside Object line will
suffice.  This indicates that the foreground object is of low complexity. The same
applies to the Outside Object lines.  If you were forced to draw them close to the
transition area because of the number of colors, details or noise in the background
area, then the background is considered to be complex.  If the background is rela-
tively consistent, lines can be drawn more loosely because the background is less com-
plex.

Other factors can affect which Transition Complexity setting will give you the best
result. For example, noisy scans can contaminate otherwise even and consistent col-
ors and require higher complexity settings. 

Processing Images
After you have drawn your Inside Object and Outside Object selections, and have
chosen the correct Transition Complexity setting, it is time to process the image and
evaluate the results.  Select Process from the file menu and Ultimatte KnockOut will
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process the image, creating an alpha channel and a new image consisting of the
processed foreground object with all of the background colors removed.

Viewing the Results After Processing
After the processing is completed, you can use the View pull-down menus or the
function keys to see three different views of the results:

F1 displays the original image.
F2 displays the knocked out image over the chosen underlay color.
F3 displays the alpha channel 

Selection Validity Testing
If you have Selection Validity Testing enabled in the Preferences palette and attempt
to process an image where your Outside Object selection does not completely
encompass your Inside Object selection, the program will refuse to process the
image.  Instead, it will generate a red rectangle surrounding the section of your selec-
tion lines showing you where the error has taken place.  In order to continue, you
will have to re-draw your selections lines so that your Outside Object selection
DOES enclose you Inside Object selection.

You can check your selection lines for errors at any time before processing by choos-
ing Check Selection Validity from the Edit menu.

Evaluating the Results and Reprocessing
After you have processed the image and examined the results, you can either save the
extracted image and associated alpha channel(s) by using the Export command, or
you can return to the original image and refine the inner and outer selections before
processing again to achieve better results. Wherever edge anomalies are found it will
be necessary to redraw the boundaries. You might have to go through the process of
making your Inside Object and Outside Object selections and evaluating the results
a few times before you achieve acceptable results. If you have enabled Previous
Process Viewing in the Preferences settings, the last, previous result of processing will
be available for comparison against the latest processing results. These views can be
toggled using the F2 key for the knocked out image over the chosen underlay color
or the F3 key for the alpha channel.
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Selecting Shadows
Shadows are retained using the same procedures used for selecting the object itself as
described above. Three separate tools, Inside Shadow, Outside Shadow and Shadow
Edge Feather , are used to make the necessary selections. Shadows cast by the subject
onto any surface, regardless of texture or color, will be retained and reproduced as a
separate alpha channel. Avoid drawing the Inside Shadow and Outside Shadow
selections through any pixels that fall within the shadow transition.  Wherever the
shadow touches the object, draw the outside selection through it as if the shadow was
a separate subject. Ultimatte KnockOut will create a fifth channel for the shadow
alpha that contains the shadow information when you Process the image.
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Using the Syringe Tools

Inside Syringe Tool

Whether or not detail such as hair will be retained and reproduced properly depends
on the inner selection passing through colors that are the same as the nearby detail
in the transition area.  You might notice after processing your image that hair has
either thinned out too much or has disappeared.  When the detail that is missing is
partially transparent and there are no opaque pixels that can be found as in the fore-
ground selection description, then its time to use the syringe tools. If partially trans-
parent hair detail is missing, then hair color from an area not affected by the back-
ground color and matching the best estimate of the color of the hair that's missing
can be “withdrawn” from one area of the image and "injected" into the problem area
using the syringe tools.  Inject as many samples as is needed to produce a proper
transparency.

IMPORTANT: The syringe tool is used to inject colors into transparent areas only.

The Inside Syringe tool is used to select a foreground color for injection into trans-
parencies that are too thin or missing after initial processing.  The color to be inject-
ed should be selected from colors like those in the missing transparency except not
contaminated by any background color.  Clicking on the color swatch next to the
Inside Syringe tool brings up the system color picker from which you can select esti-
mated colors. 

1.) Click on the Inside Syringe Tool on the Tool palette

2.) While holding down the Command key, click on a pixel in the image that 
contains the color you want to withdraw from a solid area (not from the 

problem area or any transparency area).
(or)

Click on the color swatch to the right of the tool that will bring up the 
Macintosh® System Color Picker from which a color can be selected.  

3.)  The color swatch to the right of the tool will change to the selected color.

4.) Release the Command key and click on pixels in the problem area to "inject" 
the selected color.  (Note that syringe selections are only visible when the zoom
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level is 100% or greater.)

This process can be repeated as many times and with as many colors as necessary to
correct any problems. 

To select a new color for a new area requiring correction, press the Command key
to select a new color.  Any pixels that you inject during a new sequence will create
another group of injected pixels.

Groups of pixels injected with the Inside Syringe tool can be made active by holding
down the Command and Option keys with the Inside Syringe tool selected and
then clicking directly on one of the injected pixels in a group. This will make all of
the injected pixels in that group active.  Once you have activated a group of injected
pixels, you can use the Delete key to remove them from your image.

Outside Syringe Tool

This tool works in much the same way as the Inside Syringe tool except that it is used
to select a background color for injection into transparent areas where background
color contamination still persists after initial processing. Use this tool to sample color
either from the image or the color picker that would be in the background if not
obscured by the foreground object. Clicking on the color swatch next to the Outside
Syringe tool brings up the system color picker from which you can select estimated
colors. 

1.) Click on the Outside Syringe tool on the Tool palette

2.) While holding down the command key, click on a pixel in the image that 
contains the color you want to withdraw.

(or)
Click on the color swatch to the right of the tool that will bring up the 
Macintosh® System Color Picker from which a color can be selected. 

3.)  The color swatch to the right of the tool will change to the selected color.

4.) Release the Command key and click the mouse to inject into the problem area
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with the desired color.

(Note that syringe selections are only visible when the zoom level is 100% or greater.)

This process can be repeated as many times and with as many colors as necessary to
correct problems.

To select a new color for a new area requiring correction, press the Command key
to select a new color.  Any pixels that you inject during a new sequence will create
another group of injected pixels.

Groups of pixels injected with the Outside Syringe tool can be made active by hold-
ing down the Command and Option keys with the Outside Syringe tool selected
and then clicking directly on one of the injected pixels in a group. This will make all
of the injected pixels in that group active.  Once you have activated a group of inject-
ed pixels, you can use the Delete key to remove them from your image.

The Edge Feather Tool

Sometimes portions of the foreground and background are identical and only
through visual extrapolation can we surmise where the transition ought to be.  The
foreground and background colors can be so similar that the transition area cannot
be easily identified. For example, if your subject is a polar bear in the snow, there
might be areas where it is impossible to see a definable edge transition, even when
you do a very tight zoom.  In these cases, it will be necessary for you to create an edge
transition by making your best guess as to where the boundaries lie between the fore-
ground and background.

The Edge Feather tool is provided so that you can create these non-visible edge tran-
sitions yourself. To do this, use the Inside Object and Outside Object selection tools
to draw selections where you wish to create a transition.  The Edge Feather tool will
fill the area between the inner and outer selection lines with a smooth, transparent
gradient.

After the Inside Object and Outside Object selection lines have been drawn, use the



Page 2 2 Ultimatte KnockOutUser Guide

Making and Modifying Selections

Edge Feather tool to draw an enclosed selection around the problem.  This selection
should contain the sections of the inner and outer selection lines where you want to
create an edge transition.

When you Process the image, Ultimatte KnockOut will create an edge transition that
smoothly feathers the area between the inner and outer selection lines.  You may use
the Edge Feather tool as many times as necessary in the same image.  

A separate Shadow Edge Feather tool is provided for creating feathered edges in
shadow selections.

no visible edge

zoomed view of edge feather
area defined

final result

zoomed view of image
processed without the

edge feather tool
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After you have drawn your Inside Object and Outside Object selections, it is time
to process the image and evaluate the results.  Select Process from the File menu and
Ultimatte KnockOut will process the image, creating an alpha channel and a new
image consisting of the knocked out image against the chosen underlay color with all
of the background colors removed. 

Selection Validity Testing
If you have enabled Selection Validity Testing in the Preferences palette and you
attempt to process an image where your Outside Object selection does not com-
pletely encompass your Inside Object selection, the program will refuse to process
the image.  Instead, it will generate a red rectangle surrounding the section of your
selection lines showing you where the error has taken place.  In order to continue,
you will have to re-draw your selections lines so that your Outside Object selection
DOES enclose your Inside Object selection.

You can check your selection lines for errors before processing by choosing Check
Selection Validity from the Edit menu.

Viewing the Results After Processing
After the processing is completed, you can use the function keys or the View pull-
down menu to see three different views of the results:

F1 displays the original image.
F2 displays the knocked out image over the chosen underlay color.
F3 displays the alpha channel 

Processing Images



Page 2 4 Ultimatte KnockOutUser Guide

Processing Images

Evaluating the Results and Reprocessing
After you have processed the image and examined the results, you can either save the
knocked out image and associated alpha channel(s) by using the Export command,
or you can return to the original image and refine the Inside Object and Outside
Object selections before processing again to achieve better results. Wherever edge
anomalies are found it will be necessary to redraw the boundaries. You might have to
go through the process of making your inner and outer selections and evaluating the
results a few times before you achieve acceptable results. 

If you have enabled Previous P rocess Viewing in the Preferences settings, the pro-
gram will keep two sets of selection lines and processing results in memory at the
same time:  the most recent set and the previous set.  You can toggle between these
two using the F2 key (or the F3 key if you wish to view the alpha channels) and
choose to continue refining the selection lines on either of them.   If you decide that
the results of the older processing are better than those of the latest processing, you
can use the earlier set of selections and continue working on them.  Just remember
that when you Process again that you will lose the oldest set of selection lines that
you have worked on and their corresponding processing results. 

Exporting Your Results
Ultimatte KnockOut will save processed images as a 4-channel Adobe® Photoshop®
file (or a 5-channel Photoshop file if the shadow tools were used.)   By retaining a
shadow alpha in addition to the object alpha you will be able to further manipulate
your shadow in Photoshop, such as changing the density or colorimetry of the shad-
ow only, without affecting the object.

Working with Ultimatte KnockOut files in
Adobe® Photoshop®
There are many different ways to work with layers and selections in Photoshop.  Here
we will describe two ways in which you can import and use the results from Ultimatte
KnockOut in Photoshop.
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To Composite the Processed Foreground against a new
Background Image:
1.) Launch Photoshop and begin by opening both images with which you will 

be working: the background image with which you wish to composite and 
the processed foreground created by Ultimatte KnockOut.

2.) With the processed foreground image active, use Photoshop's Channels 
palette to display the RGB channels of the processed foreground.   Load the
object alpha channel as a selection and the marching ants will appear.

3.) Copy the selection.
4.) Select the background image into which you will be placing the knocked out

image and select Paste. 
5.) Go to the layer menu and choose Layer/Matting/Remo ve Black Matte.

IMPORTANT: You must remove the black matte in order to carry out an additive
mix which will allow for the proper blending of the processed foreground with the
new background. 

The object which you "Knocked Out" is now a new layer in the target image and can
be manipulated as you see fit.

Shadow Selections
If you saved your work as a 5-channel image file, the shadow alpha channel will be
created separately from subject alpha channel. Continue from above with the fol-
lowing steps to include it in the final composite:

6.) With the processed foreground selected, copy the shadow alpha channel into
a new channel in your background image.

7.) With the layer directly beneath the object you knocked out selected, load the
shadow alpha channel.

8.) While writing on this layer, choose New Adjustment Layer from the 
Layers palette pull-down menu.  The Levels dialogue box will appear and 
you can set the output levels of the channel to achieve the desired level of 
gray in the shadow.

8.) Ensure that shadow layer is under (behind) the foreground layer.
9.) Use the move tool to place the shadow in the desired position.

The shadow that you "Knocked Out" is now a new layer in the target image and can
be manipulated as you see fit.
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To manipulate the foreground selection 
in the original image:
This process is useful for selecting specific image areas, to apply filters or effects or
making other adjustments:

1.) Launch Photoshop and begin by opening two images: the original image and the
image that you have processed in Ultimatte KnockOut. 
2.) Copy the alpha channel of the processed foreground into a new channel in the
original image.
3.) Click on the RGB channel to make the RGB channels visible.
4.) Load the alpha channel selection.
5.) Manipulate the selection as you wish and save.

Note that when manipulating a selection in the manner just described, it is not nec-
essary to remove the black matte since there is no compositing being performed.
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The Tools Palette

Inside Object Tool

• Use to draw the lines that define the interior colors at the transition area 
of the foreground object.

• Use with the Shift key depressed to add to the Inside Object selection.
• Use with the Control key depressed to add a single pixel to the selection

(cursor will change to a push-pin)
• Use with the Option key depressed to subtract from the Inside Object selection.
• Use with both the Control and Shift keys depressed to constrain the tool to straight

lines while adding to your selection.
• Use with both the Control and Option keys depressed to constrain the tool to 

straight lines while deleting from your selection.
See Pages 6-7 for additional information.

Outside Object Tool

• Use to draw the lines that define the color in the background at the transition area
of the foreground object.

• Use with the Shift key depressed to add to the Outside Object selection.
• Use with the Option key depressed to subtract from the Outside Object selection.
• Use with the Control key depressed to subtract a single pixel from the selection. 

(cursor will change to a pair of tweezers)
• Use with both the Control and Shift keys depressed to constrain the tool to straight

lines while adding to your selection.
• Use with both the Control and Option keys depressed to constrain the tool to 

straight lines while deleting from your selection.
See Pages 6-7 for additional information.
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Inside Shadow Tool

• Use to draw the lines that define the interior of the transition area within a shadow
to be retained.

• Use with the Shift key depressed to add to the Inside Shadow selection.
• Use with the Control key depressed to add a single pixel to the selection 

(cursor will change to a push-pin)
• Use with the Option key depressed to subtract from the Inside Shado w selection.
• Use with both the Control and Shift keys depressed to constrain the tool to straight

lines while adding to your selection.
• Use with both the Control and Option keys depressed to constrain the tool to 

straight lines while deleting from your selection.
See Pages 7 and 43-44 for additional information.

Outside Shadow Tool

• Use to draw the lines that define the outside of the edge area surrounding 
the shadow.

• Use with the Shift key depressed to add to the Outside Shadow selection.
• Use with the Option key depressed to subtract from the Outside Shado w shadow
selection.
• Use with the Control key depressed to subtract a single pixel from the selection 

(cursor will change to a pair of tweezers)
• Use with both Control and Shift depressed to constrain the tool to straight lines 

while adding to your selection.
• Use with both Control and Option depressed to constrain the tool to straight lines

while deleting from your selection.
See Pages 7 and 43-44 for additional information.



Page 3 0 Ultimatte KnockOutUser Guide

The Palettes

Inside Syringe Tool

This tool is used for transition areas where it is not possible to sample the appropri-
ate foreground color using the Inside Object tool.  Use this tool with the Command
key depressed to withdraw a color that is representative of the foreground color in the
transition you would like to preserve. Release the Command key to inject the color
into the appropriate area.
See Pages 19-20 for additional information.

Outside Syringe Tool

This tool is used for transition areas where it is not possible to sample the appropri-
ate foreground color using the Outside Object tool.  Use this tool with the
Command key depressed to withdraw a color that is representative of the back-
ground color in the transition you would like to preserve. Release the Command key
to inject the color into the appropriate area.
See Pages 20-21 for additional information.

Edge Feather Tool

Use the Edge Feather tool to create edge transitions in areas where the foreground
and background colors are so similar that the transition area cannot be easily identi-
fied.  Encircling an area containing Inside Object and Outside Object selection lines
with this tool will create a soft gradation between the selection lines.
See Pages 21-22 for additional information.
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Shadow Edge Feather Tool

Use the Shadow Edge Feather tool to create edge transitions where the foreground
and background colors are so similar that the transition area cannot be easily identi-
fied.  Encircling an area containing Inside Shado w and Outside Shado w selection
lines with this tool will create a soft gradation of shadow between the selection lines.

The Pan Tool

Select the Pan tool from the Tools palette to pan the image around inside the display
window. You can access the Pan tool temporarily without changing from your cur-
rent selection tool by holding down the spacebar on the keyboard.

The Zoom Tool

Use the Zoom tool to zoom in and out in the image display window.  Click on the
magnifying glass icon, then click in the image area you want to magnify. Hold down
the Option key while clicking on the image to zoom out.

You can also access the Zoom tool temporarily without changing from the current
object selection tool by holding down the Command key and the Spacebar at the
same time. Similarly, you can zoom out by holding down the Option key and
Spacebar simultaneously. You can also use Command + to zoom in or Command
- to zoom out.
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Transition Complexity

The Transition Complexity settings have an important effect on how an image is
processed.  They are provided so that you can instruct the program about the nature
of the transition area.  There are four settings available that can have a rather pro-
found effect on how the program processes the information that you have provided
it by drawing your selections.  These are:

1.) Low
2.) Low to Medium 
3.) Medium to High
4.) High

Deciding which setting is best for any particular image depends upon the complexi-
ty of the transition area, i.e., the area between the Inside Object and Outside Object
selections that you draw. We suggest that you read the descriptions and examples
below and try processing the same image with different Transition Complexity set-
tings while noting the results.

1.) Low - Use for images with uniform, simple colors in both the foreground and the
background. Images with low noise levels, minimal detail and narrow transition
widths can be processed with this setting. 
Example:  A white stuffed animal on a single-color background.

2.) Low to Medium - Use for images with more complex foregrounds but with rela-
tively simple backgrounds.  The foreground object can have more detail and more
variable colors in the transition area.  Wider edge transitions are acceptable. The
background remains even and consistent. 
Examples:  Studio portraits. People (with hair) against a uniform background.  In-
focus shots of most subjects against even backgrounds.

3.) Medium to High - Use for images where the foreground is relatively simple and
the background is complex and/or grainy. This setting can handle wider transitions,
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soft blurs, out-of focus edges and motion blurs in the foreground. 
Examples:  A drinking glass against a solid-color background.  A plain, brown teddy
bear on a plaid background. 

4.) High - Use for images where both the foreground and background contain a great
amount of detail along the transition. The best setting for transition edges where
both the inner and outer lines are drawn close to the edge transition.  
Examples:  A single person to be extracted from a crowd scene.  A leopard in a field
of flowers.

A good indicator of which Transition Complexity setting you should use is the prox-
imity of the lines you have drawn near the edge transition area.  Remember that the
lines you draw must cross through the colors that make up the beginning of the tran-
sition.  So, in a case where colors remain consistent from deep inside an object all the
way to the beginning of the edge transition, a loosely drawn Inside Object line will
suffice.  This indicates that the foreground object is of low complexity. The same
applies to the Outside Object lines.  If you were forced to draw them close to the
transition area because of the number of colors, details or noise in the background
area, then the background is considered to be complex.  If the background is rela-
tively consistent, lines can be drawn more loosely because the background is less com-
plex.

Other factors can affect which Transition Complexity setting will give you the best
result. For example, noisy scans can contaminate otherwise even and consistent col-
ors and require higher complexity settings. 
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The Selections Palette

Use the Selections palette to hide or display any or all of the selection lines you have
drawn. Click on the eyeball next to the desired selection to turn its display on or off.
As an alternative, you may also hide or display any of the selection lines by using the
choices presented in the Selections menu. You can also use Command H to hide or
show all selections simultaneously. The Selections palette is accessed from the
Windows menu.

The Info Palette

X,Y
Displays the X and Y coordinate values for the pixel under the cursor.

RGB 
Displays the Red, Green and Blue (RGB) values for the pixel under the cursor.

The Info palette is accessed from the Windows menu.
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The Underlay Color Palette

After you have processed an image you can use the F2 function key (or choose
Knocked Out from the View menu) to display the processed foreground against a
color to get an idea of how it will appear against the colors in your final composite.
The Underlay Color palette lets you select which color will be used with the F2 key.
You can select any of the fifteen available colors by clicking on the color swatches in
the palette. The Underlay Color palette is accessed from the Windows menu. Note
that these colors are displayed for preview purposes only and will have no effect on
the processed foreground that is output when you export the image.
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The Caps Lock key can be used at any time to turn the mouse cursor into crosshairs.

The File Menu
Open (Command O) - Opens either a previously saved project or a new image file
Close (Command W) - Closes the current display window.

Save Project (Command S) - Saves your project file, including the lines you have
drawn. Projects are saved using a proprietary file format for Ultimatte 
KnockOut with the file extension .UKO.

Save Project As... - Allows you to save a project file with a new name.  Projects are
saved using a proprietary file format for Ultimatte KnockOut with the file 
extension .UKO.

Export (Command E) - Exports the processed foreground and alpha channel(s) as 
an Adobe Photoshop file with a _PFG.PSD (processed foreground) extension.

Quit (Command Q)- Quits the program.

The Edit Menu
Undo (Command Z) - Undoes the last selection.
Process (Command P) - Processes the image, creates the alpha channel and 

composites the results against the chosen underlay color.

The Tools Menu
You can move from tool to tool within the Tool palette by using the numeric keypad
on the keyboard (the 4 and 6 keys).  The menu versions are provided as an a d d e d
convenience.

Menus Selections and
Keyboard Shortcuts
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Inside Object - Used for selecting the inside of the object transition area.
Outside Object - Used for selecting the outside of the object transition area.

Inside Shadow - Used for selecting the inside of the shadow transition area.
Outside Shadow - Used for selecting the outside of the shadow transition area.

Inside Syringe - Use this tool to withdraw a color or colors from the image or the 
color picker that you would expect to see and inject it into the problem area.

Outside Syringe - Use this tool to withdraw the color or colors either from the image
or color picker that you assume would to be in the background if the 
foreground object was not in the shot.

Edge Feather - Use this tool to define areas between the Inside Object and Outside
Object selection lines where you would like to create a feathered edge 
transition.

Shadow Edge Feather - Use this tool to define areas between the Inside Shadow and
Outside Shado w selections where you would like to create a feathered edge
transition.

Pan (Spacebar) - Allows you to pan around the image inside the display window.
Zoom (Command +) (Command -) - Zooms in or out of the image once if the 

Zoom tool is selected
(Command Spacebar) and (Command Option Spacebar ) - Activates the Zoom 

tool and zooms in or out of the image.

The Selections Menu
None (Command D) - Deletes all the selections created using the currently selected

tool. 
Select All - Selects all of the image using the currently selected tool.
Invert - Inverts the active selection.

Hide All/ Show All (Command H) - Hides/Shows all selection lines.

Hide/Show Inside Object - Hides/Shows the Inside Object selection(s).
Hide/Show Outside Object - Hides/Shows the Outside Object selection(s).

Hide/Show Inside Shadow - Hides/Shows the Inside Shadow selection(s).
Hide/Show Outside Shadow - Hides/Shows the Outside Object selection(s).

Hide/Show Inside Syringe - Hides/Shows the Inside Syringe selections.
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Hide/Show Outside Syringe - Hides/Shows the Outside Syringe selections.

Hide/Show Edge Feather - Hides/Shows the Edge Feather selections.
Hide/Show Shadow Edge Feather - Hides/Shows the Shadow Edge Feather

selections.

Auto Inside/Outside - Automatically generates a "best guess" selection based upon
a previously drawn one.  If you draw the Inside Object selection first, it will
use it to generate an Outside Object selection.  If you draw the Outside 
Object selection first, it will use it to generate an Inside Object selection

Expand  (Command ] ) - Will expand the currently active selection by one pixel for
every push of the right bracket key.

Contract (Command [ ) - Will contract the currently active selection by one pixel
for every push of the left bracket key.

The View Menu
Original (F1) - Displays the original image.
Knocked Out (F2) - Displays a composite with the chosen underlay color.
Alpha (F3) - Displays the alpha channel.

The Windows Menu
Hide/Show Tools (Tab) - Toggles the Tool palette off and on.
Hide/Show Info - Toggles the Info palette off and on.
Hide/Show Underlay - Toggles the Underlay Color palette off and on.
Hide/Show Selections - Toggles the Selections palette off and on.

Zoom In (Command +) - Zooms in on the image.
Zoom Out (Command -) - Zooms out from the image.

Fit Window (Command 0) - Forces the image into the dimension of the display 
window.

100% View (Command Option 0) - Displays the actual pixel resolution 
(unzoomed view) of the image.
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Tutorial #1
Creating Inside Object and Outside Object Selections 
on a simple image

1.) Open the image entitled Bear from the Ultimatte KnockOut CD.

2.) Using the Inside Object tool, 

create a selection line that traces along the interior of the bear, without 
entering into the transition area.  Use the Shift key to add to your selection, 
and the Option key to subtract from your selection until the line looks similar 
to the one shown below.

Tutorials

correct

incorrectincorrect
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3.) Use the Outside Object

tool and create a selection line around the outside the edges of the bear's 
fuzzy coat.

4.) Edit the outside selection until it looks similar to the one in the screen shot. 
Use the Shift key to add to your selection, and the Option key to subtract 
from your selection.

5.) Set the transition complexity on the tool palette to 1 (Low).

6.) Select Process from the Edit menu (or use Command P) to process the 
image.

7.) If necessary, modify the Inside Object and Outside Object lines and reprocess 
the image.

8.) Name and save your project using Save Project As... from the File menu.

9.) Use Export from the File menu to save the processed foreground and the alpha
channel and follow the instructions on Pages 24-25 to work with the 
image in Adobe® Photoshop®.

An Ultimatte KnockOut project called Bear.UKO is also included if you would 
like to compare your project with a completed one.

correct

incorrectincorrect
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Tutorial # 2
Preserving Shadows

1.) Open the project called shadow.UKO from the Ultimatte KnockOutCD. Use 
the Preferences palette from the Edit menu and make sure that the Shadow
Memory Buffer is enabled. Note that the Inside Object and Outside Object
selections have already been created for you and that Transition Complexity is
set to 2.

2.) Click on the eyeballs in the Selections palette to hide the display of the 
Inside Object and Outside Object selection lines

3.) Using the Inside Shadow tool, 

create a selection around the inside of the shadow while being careful not to 
draw your line in the transition area along the outside edge of the shadow.
Use the Shift and Option keys to add or subtract from the Inside Shadow
selection as necessary.  In the area where the shadow touches the edges of the 
toy dog, your selection should extend into the toy itself.
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4.) Using the Outside Shadow tool, 

draw a selection around the area outside of the shadow. Use the Shift and 
Option keys to add or subtract from the Outside Shado w selection as 
necessary.  As before, in the area where the shadow touches the edges of the toy
dog, your outside selection should extend into the dog itself.

5.) Process your image using Command P and examine the results.  Use the F1,
F2 and F3 keys to see the original image, the knocked out image against an 
underlay color and the alpha channel, respectively. You can change the 
underlay color by clicking on any of the colors in the Underlay Color palette.

6.)  Use Export from the File menu to save the processed foreground and the alpha
channel  and follow the instructions on Pages 24-25 to work with the 
image in Adobe® Photoshop®.
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Tutorial #3
Using the Syringe Tools

1.) Open the project entitled syringe.UKO from the Ultimatte KnockOut CD.  A 
requester will appear, asking if you would like to process the image.  Accept by
clicking on the Process button in the requester. We have already created the 
Inside Object and Outside Object selections and correctly set the Transition 
Complexity to 3.

2.) Use the F1 key to view the original.

3.) Use the Zoom tool to magnify the right side of the image. Remember that 
syringe selections are only visible when the zoom level is 100% or greater.
Using the F1 and F2 keys to examine the processed image, you’ll notice that 
some areas of the model’s hair in the transition have become too transparent.  
This is because our inner line is as close to the transition as possible without 
entering the transition and is not able to pass through the colors which are in 
those strands of hair. The hair in the transition is a different color than those 
through which the inner line passes. Don’t use the single pixel Pushpin tool in 
this area because that would make the hair 100% opaque and we wish to 
preserve the transparency. We can repair this by using the Syringe tools.

4.) Select the Inside Syringe tool from the Tool palette.  

While holding down the Command key, click on a representative light brown
color in the area of the woman’s hair shown in Figure 3.1 and click the mouse 
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to withdraw a color that represents the color we would see in the problematic 
hair area if the background color were not contaminating the transparency 
colors. Notice the color swatch update to the color you have chosen.  

5.) Release the Command key, and inject several points on the section of 
problem hair. This will inject the color into the thinned-out hairs as shown in
Figure 3.2.

6.) (optional)  If you would like to see the result of this operation before we
continue and make another syringe injection, Process the image now
(Command P), then use the F1 and F2 keys to compare the original image to
the results obtained through the use of the Syringe tool.

7.) Notice that another area of bright, backlit wisps of hair shown in Figure 3.3 is 
still too transparent. Again using the Inside Syringe tool and Command key,
withdraw a color from the bright, highlighted wisp of hair that falls in front 
of the model’s forehead (see Figure 3.3).  Release the Command key and 
inject a couple of points into the second problem area that should have similar,
nearly-white highlights (as in Figure 3.4).

figure 3.1

figure 3.2

figure 3.3 figure 3.4
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8.) Process the image using the menu selection or Command P.

9.) Your results will be much improved, with natural-looking hair and accurate 
highlights.

10.) Use Export from the File menu to save the processed foreground and the 
alpha channel and follow the instructions on Pages 24-25 to work with the 
image in Adobe® Photoshop®.

An Ultimatte KnockOut project called syringe_completed.UKO is also included if
you would like to compare your syringe project with one where the syringe selec-
tions have been made for you.
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Tutorial #4
Using the Edge Feather Tool

1.) Open the project called edgefeather.UKO from the Ultimatte KnockOut CD.  
A requester will appear, asking if you would like to process the image.  
Accept by clicking on the Process button in the requester.  Note that the 
Inside Object , Outside Object and Syringe selections have already been 
created for you and that Transition Complexity has been set to 3.

2.)  Use the F1 key to view the original. Observe the area near the lower left-hand 
corner of the image just below the top of the model's shoulder. The back-lit 
edge of her fluffy sweater merges with the background colors in such a way as 
to make it impossible to see any color difference between the sweater and the 
background.

zoomed view of area with no visible transition
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3.) Use the F2 key to look at the knocked out subject against an underlay color 
and you will discover that this area does not knock out properly -- the edge 
looks ragged and unrealistic.  The Edge Feather tool is provided for situations 
just like this.

4.) To repair this problem, create an enclosed selection using the Edge Feather
tool that encircles the area.  The selection should contain the sections of the 
Inside Object and Outside Object selection lines where you want to create an 
edge transition where none exists. The Edge Feather tool will create a smooth, 
transparent transition between the Inside Object and Outside Object selection
lines.  You can determine the width and shape of the feathered edge by varying
the shapes of your selection lines and their distance apart. In this case, we drew
the inner and outer selection lines for you and based their distance from one 
another and their shapes upon the width of the "naturally occurring"
transition that can been seen in other areas of the sweater's edge.

unacceptable result after processing without the Edge Feather tool

selection created with the Edge Feather tool surrounding Inside
Object and Outside Object selections
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5.) Process the image (Command P) and see how the program has created a 
smooth transition between the Inside Object and Outside Object selection 
lines in the area you defined with the Edge Feather tool.

6.)  Use Export from the File menu to save the processed foreground and the alpha
channel  and follow the instructions on Pages 24-25 to work with the 
image in Adobe® Photoshop®.
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• When in doubt, draw your lines closer to the transition area!

• Noisy scans and film grain can cause a faint, ghosty, halo effect in the transition 
area.  Once composited, this effect usually becomes unnoticeable, depending 
upon the background against which it is placed. If necessary, you can minimize
this halo effect by drawing your outside object lines closer to the transition area.

• When working with your image, it is often very helpful to use the Selections 
palette to turn different selection tool displays on and off to avoid clutter on the 
screen.

• The Selections palette can be used to turn off inside and outside selections to 
help differentiate between single pixel (Pushpin or Tweezer) selections and 
syringe selections.

• When trying to decide whether to use the Inside Syringe or Outside Syringe 
tools, first try the tool for which you can make the best estimate of the color to 
be withdrawn.

• Transparent objects can often be almost totally transition area.  A water glass, for
example, might only require a few single pixel, Inside Object selections in areas 
with highlights.

• Don’t forget to select the correct Transition Complexity setting before
processing your image.  When in doubt, try a couple of different settings and 
compare the results.

• With complex images, it is sometimes more efficient to do a little touchup work
to the alpha channel and/or processed foreground in Photoshop than to try to 
create a perfect knock out every time with Ultimatte KnockOut.

Hints and Tips 
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• It is important to zoom in far enough so that you can actually identify the edge 
transitions.  Make sure that you can see the prevailing outside colors(s), the 
transition and the prevailing inside color(s).

• After processing, toggle back and forth several times between the original image 
and the knocked out image using the F1 and F2 keys to get a good view of how
processing has affected the transition areas.  Similarly, if you have enough RAM 
and have the View Previous Process function activated, toggle between your cur
rent and previous process to get a better idea of how changes to your selections 
have affected your results.

• Using Ultimatte KnockOut is an art.  Artistic decisions are often required to 
determine whether an area is part of the object or part of the background or 
whether an area is partially transparent or opaque.  

• It is not possible in this document to describe every kind of transition that can 
exist.  Careful experimentation and experience using the program will help you 
develop an intuitive feel for how to handle transitions and where to draw you 
selection lines.

• It is usually easiest to draw “quick-and-dirty,” loose selection lines at a zoom 
ratio where the entire object to be knocked out can be seen, and then zoom in 
more tightly to add or subtract from the selection lines.

• Don’t forget to use the Auto Inside/Outside function to create one set of 
selection lines for you.  This function works best on images where the Inside 
Object and Outside Object selections will have a similar overall shape.

• The Edge Feather tool can solve seemingly impossible problems.  Instead of 
spending an inordinate amount of time trying to preserve a section of an image 
that is complex and difficult to mask out properly, just create your own 
transition using the Edge Feather tool. (Once again, your artistic sensibilities 
will be called into play.)

• VERY IMPORTANT: Don’t forget to use the Remove Black Matte function in 
Photoshop when compositing your results (see Page 25 for more complete 
instructions).

• Single pixel selections for Inside  Object or Outside Object selections should be 
used only on areas that are 100% opaque.  In partially transparent, transition 
areas, use the syringe tools.
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In the studio, any backdrop that has no fine detail in focus should work well.  Avoid
close color and brightness matches between the backdrop and the edges of the fore-
ground object, particularly hair, to be knocked out.  Grain in the film, if bad enough,
can produce a grainy ghost effect in the backdrop area.  Always try to use the slow-
est, fine grain film as possible to minimize the phenomena.  Avoid over exposure of
either the backdrop or the subject, particularly near transition areas.  When over
exposure occurs the result is typically color tints in the edge transitions.  Colored
edges can also be caused by lens chromatic aberrations.  The solution for this prob-
lem is to choose a lens with a minimum amount of aberrations.

Colored edge transitions can also be inadvertently generated when the image is
scanned.  Whether the scan is 8, 10, or 16 bits, verify that there is no clipping of any
detail in the blacks or whites.  Do not do any kind of secondary or area isolated color
correction on the image before using Ultimatte KnockOut. Always color correct after
using Ultimatte KnockOut.

When shooting out of the studio and the backdrop is a natural setting, keep in mind
that the easier it is to see the hair detail through the view finder the easier it will be
to knock it out later.  Narrow depth of field is very helpful in this regard so a long
focal length lens is advisable where possible.  A fast shutter speed requiring a low f-
stop is another good way to help separate the subject from a busy background.
Sometimes by simply having the subject or the camera move a few inches left or
right, up or down, important fine detail can be positioned against the background to
achieve a more favorable visual separation which will knock out more efficiently later.

Always try to place smooth, even surfaces behind glass and smoke if at all possible.
This will allow for a very effective knock out of these never-before-possible fore-
ground subjects.

Photography 
and Scanning Techniques
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There is one phenomena to try to avoid.  It is important to bring this up for two rea-
sons.  First, if the photograph has already been taken and you’re trying to deal with
the problem, it’s important to know the limitations.  Secondly, if you have any con-
trol over the photography the problem can be avoided very easily. The phenomena
occurs when someone with black or nearly black hair is shot against a plain gray
backdrop. The highlights in the hair will show a full gamut of gray scale that will
have the same exact gray that exists in the backdrop.  Because many of these high-
lights will be found in the area defined as transition, those highlights that have the
same, or nearly the same, shade of gray as the backdrop will become transparent just
as if it were backdrop. When composited against a new background image that is
similar to, or lighter than, the original backdrop the loss of highlights is little noticed.
When the new background image is noticeably darker than the original backdrop,
then the loss of highlights in the affected area leaves the hair appearing flat.  The clos-
er the new background image is to the actual hair color the more problematic it
becomes because the highlights are what would normally visibly differentiate
between the dark hair and the dark background.  

At the time of photography the solution is to not use gray for the backdrop.  Use a
backdrop that has some actual color.  Pastels will work best in this scenario. If a high-
ly saturated backdrop is chosen, there is no concern of producing edge effects or
reduction of fine detail when scanned properly and used with Ultimatte KnockOut.
However, you should beware of lens flare that may be introduced resulting in the
contamination from the backdrop color onto the overall image.  If this is the case,
some color correction may be necessary after the subject has been Knocked Out and
during the compositing process.
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